Web-based SPAR — Account Inquiry (No Subcode) Screen

Account Inquiry (No Subcode) Screen Purpose

The Account Inquiry (No Subcode) Screen provides details of salary distribution for individuals charged to an account

by:
- 28-digit account number (omitting the 4-digit subcode) and one-character cost share code
- Specific time period
- Specific payroll name

I LogIn
A. Log in at my.pitt.edu
B. Access PRISM
C. From the Main Menu, choose the PLD role you have been assigned

Il.  Select Account Inquiry - No Subcode Screen
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1R Account Inquiry - No Subcode Input
A. Account Number

Type a 28-digit account number (32-digit minus the subcode) plus the one-character, uppercase cost-

share code directly in the Account Number field and click Find.



TIP: Include periods between the account segments.

TIP: This screen uses a 28-digit account number format, omitting the 4-digit subcode and adding the one-
character upper case cost share code, XX.XXXXX. XXXXX. XXXXXX. XXXXX. XXXXX.X.

TIP: The one-character cost-share code is case sensitive.

TIP: To view all salary distribution to an account, multiple queries may be necessary if more than one
subcode, cost share code, or reference number has been used.

B. Payroll Name From and Payroll Name To

Input Option 1: Type directly in the Payroll Name From or Payroll Name To field

Type the 2-digit month, space, and 4-digit year (ex: 09 2012)

Click Find (to the right of the Payroll Name To field) or hit the Tab key
Highlight the line for the correct Payroll Name

Click OK
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Input Option 2: Click in the Payroll Name From or Payroll Name To field and click on the three dots
on the right side of the field. Make selection using the below options.

a. Scroll through the list using the scroll bar on the right of the box and highlight the selection
1. Click OK

b. Inthe Find field, click to the left of the % sign

Enter the 2-digit month, space, and 4-digit year before the % sign
Click Find to select from all Payroll Names for that month
Highlight the line for the correct Payroll Name

Click OK

P wNPR

When both Payroll Name fields have been completed, or the Payroll Name From field if only querying
one montbh, click Find (to the right of the Payroll Name To field) to obtain the results.

TIP: To view all salary distributions for the life of the account, do not enter limits in the Payroll Name
From or Payroll Name To fields. Click Find. The SPAR application has historic salary distribution
information back to July 2002.

TIP: To view salary distributions for a single month, enter only the Payroll Name From field and click
Find.

TIP: To view salary distributions for a specific date range, enter both the Payroll Name From and Payroll
Name To fields. Click Find.

TIP: If you change the Payroll Name From value after a value is entered for Payroll Name To and Click
Find, only the distribution information for the new Payroll Name From month will display. You will need
to re-enter the Payroll Name To field to extend the range.

TIP: Enter date format as 2-digit month and 4-digit year (09 2012).




V.

Payroll Name From Screen

Payroll Marme From

Find %

Payroll Name Start Date End Date Oracle Payroll Mame Qracle Perind Mame =]
11 2011 Pitt Manthly O01-MOW-2011 30-MNOV-2011  Pitt Manthly 11 2011 Calendar Manth
12 2011 Pitt Monthiy 01-DEC-2011  31-DEC-2011  Pitt Monthly 12 2011 Calendar Month
01 2012 Pitt Monthly 01-JAN-2012  31-JAR-2012 Pit Monthly 12012 Calendar hionth
02 2012 Pitt Manthly 01-FEE-2012  28-FEB-2012  Pitt Manthly 22012 Calendar Manth
03 2012 Pitt Monthiy 01-MAR-2012  31-MAR-2012  Pitt Manthly 32012 Calendar Month
04 2012 Pitt Monthiy 01-APR-2012  30-APR-2012  Pitt Monthly 42012 Calendar honth
05 2012 Pitt Monthly 01-WAY-2012  31-MAY-2012  Pilt Monthly 52012 Calendar honth
06 2012 Pitt Manthly 01-JUM-2012  30-JUN-2012  Pitt Manthly B 2012 Calendar Manth
07 2012 Pitt Monthiy 01-JUL-2012  31-JUL-2012  Pitt Monthly 7 2012 Calendar Month
08 2012 Pitt Monthly 01-AUG-2012  31-AUG-2012  Pilt Monthly 82012 Calendar honth
09 2012 Pitt Monthly 01-8EP-2012  30-5EP-2012  Pitt Monthly 92012 Calendar Month
10 2012 Pitt Manthly 01-0CT-2012  31-0CT-2012  Pitt Manthly 10 2012 Calendar Manth
11 2012 Pitt Monthiy 01-ROY-2012  30-ROY-2012  Pitt Monthly 11 2012 Calendar Month
122012 Pitt Monthly 01-DEC-2012  #31-DEC-2012  Pilt Monthly 122012 Calendar Month
01 2013 Pitt Manthly 01-JAM-2013 A1-JAN-2013 Pitt Manthly 12013 Calendar Manth
02 2013 Pitt Monthiy 01-FEE-2013  28-FEB-2013  Pitt Monthly 22013 Calendar Month
03 2013 Pitt Monthiy 01-MAR-2013  31-MAR-2013  Pitt Monthly 32013 Calendar Month
04 2013 Pitt Monthly 01-APR-2013  30-APR-2013  Pitt Monthly 42013 Calendar Month
0& 2013 Pitt Manthly O01-MAY-2013 31-MAY-2013  Pitt Manthly 52013 Calendar Manth
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Output Screen
A. Account Inquiry (No Subcode) screen will populate with data specific to the query that was run.

TIP: Only individuals in the area of the user’s level of security access will be displayed —if paying salary on
an account for an individual outside the academic area of responsibility, the individual will not appear on
the list. In order to gain access to this information, subset access must be requested from the individual’s
home department.

TIP: The output reflects distribution dollars for the specified month and will not match total charges for
an individual appearing on your Labor Distribution reports for situations where retroactive salary
reallocations have been made. Retroactive reallocations update the respective SPAR month and,
conversely, appear on the Labor Distribution reports in the month in which the reallocation was
processed.

TIP: A checkmark (M) in the Adjustments column indicates that a retroactive adjustment for the specific
period was processed. Clicking on the Detail box will provide the information on the initial distribution
and any subsequent adjustments/reallocations.

TIP: When viewing the Detail screen for retroactive adjustments, click the Other Side box to identify the
account number representing the other side of the transaction.



Account Inquiry Screen (No Subcode) Including Search Criteria

Account Inquiry (No Subcode)

Payrall Name Fram
09 2012 Fitt Monthly

Payrall Name Ta

Account Mumber (No Subcode) e —

02, 2229100000, 0000000700, 00000, M

Adjustmants
Detail Full Narme

b

SPAR Req

Emp Mumber Subcode  Amount Fayroll Name Elemant Name Element  Action Type

Tatal

Account Inquiry Screen (No Subcode) Result
B
Account Inquiry (No Subcode)

Account Mumber (No Subcode)
(0222291 00000.000000.01000.00000.M

Paytroll Narme From
08 2012 Pitt Manthly

Payroll Narne To
10 2012 Fitt Maonthly

Adjustments SPAR Rey
Datail Full Name Emp Number Subcode  Amount Payroll Name Element Name Element  Action Type
» SPAROD, Faculty B 144147 5100 8,000.00 10 2012 Pitt Monthly Fitt Regular Salary N Run =
_ SPAROD, Faculty F 143937 5100 16,000.00 |10 2012 Pitt Monthly Pitt Regular Salary i Run
_J SPARDD, Faculty J 144021 5100 20,000.00 [10 2012 Pitt Monthly Pitt Regular Salary A Run
) SPAROD, Staff B 144105 5400 3,000.00 |10 2012 Pitt Monthly Pitt Regular Salary A Run
_ SPARDT, Faculty B 144148 5100 8,000.00 10 2012 Pitt Monthly Pitt Regular Salary i Run
_J SPARDT, Faculty F 143936 5100 16,000.00 10 2012 Pitt Monthly Pitt Regular Salary ¥ Run
) SPAROT, Faculty J 144022 a100 20,000.00 (10 2012 Pitt Monthly Pitt Regular Salary A Run
/¥ [SPARDT, Staff A 144085 5400 3,000.00 10 2012 Pitt Monthly Pitt Regular Salary A Run
_J SPARDT, Staff B 144106 5400 3,000.00 10 2012 Pitt Monthly Pitt Regular Salary i Run
) SPAROZ, Faculty B 144149 a100 8,000.00 |10 2012 Pitt Monthly Pitt Regular Salary A Run
) SPARDZ, Faculty F 143933 5100 16,000.00 |10 2012 Pitt Monthly Pitt Regular Salary A Run
_J SPARD2, Faculty J 144023 5100 20,000.00 10 2012 Pitt Monthly Pitt Regular Salary i Run
_ ) ¥ [SPARD2, Staff A 144086 5400 3,000.00 [10 2012 Pitt Monthly Pitt Regular Salary \ Run
) SPAROZ, Staff B 144107 5400 3,000.00 |10 2012 Pitt Monthly Pitt Regular Salary A Run
_ SPAROE, Faculty B 144150 5100 8,000.00 10 2012 Pitt Monthly Pitt Regular Salary i Run =
Total 1,883 000.00

The results of the Account Inquiry No Subcode include monthly salary dollar distributions for all individuals

within your area of access charged to the specified account for the period indicated. Individuals with a

retroactive salary adjustment are identified by a check in the Adjustments box. Information related to the

adjustment is available by clicking the Detail field at the beginning of the line. A Detail Screen will appear that

reflects the initial distribution, the salary reallocation, and the net charge to the account for the month

appearing in the Payroll Name field.



Detail Screen

=
Detail
Full Name

SPARDT, Staff A CLOSE

Other

Side Account Number Amount Source Created By Creation Date
02.22291.5400.00000.000000.01000.00000. 4 75000 Percentage Adjustment SPARDD, Faculty E 24-JUL2012 =
02.22291.5400.00000.000000.01000.00000. 1 3,000.00 |Percentage Adjustment SPARDD, Faculty E 24-JUL2012

Total 2,250.00

From the Detail Screen you can drill down to an additional level that will provide both the debit and credit side of
the entry for a specific line. Click Other Side at the beginning of the line to view the Detail Other Side Screen.

Detail Other Side Screen

=
Detail Other Side
Account Murmber Arnount
02.22291 .5400.00000.000000.01000. 00000 3,000.00 CLOSE

OTHER SIDE OF TRAMSACTION

Account Mumber Armount
02.22275 . 5400.00000.000000. 01000, 00000, 1 -3,000.00 =
Taotal -3,000.00

V. Export Data
A. Click Export from the File Menu in the upper left hand corner.
B. Follow directions for Exporting files found in Appendix I, Web based SPAR — Exporting Data

VL. Exit Account Inquiry Screen
C. Click the upper right hand corner X to exit, or
D. Click the red box in upper left hand corner and click Close



Appendix |I: Web-based SPAR - Exporting Data from the Web-based SPAR

This function can be used for Account Inquiry (with or without subcodes), Person Inquiry, SPAR Modification History,

and Labor Distribution and Cost Sharing screens.

TIP: On the SPAR History Modification screen, only the Status screen will export, the Status Detail screen
will not.

To export from the Labor Distribution and Cost Sharing Screens, you must export the Effort Reporting and Distribution
(top) and the Cost Sharing (bottom) sections separately. Click in the section to be exported.

I For Computers with Adobe Reader:

A.
B.
o
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Go to File on Toolbar at top of page.

From drop down menu, select Export.

The Oracle Application page will open. On the bottom you will see a message “Do you want to open or save
XXXXX". Select Open.

A notepad will open with all the data you requested.

To date stamp the version of information you are using, go to Edit and select Time/Date.

To print data in the notepad format, select Print from the File menu.

To export the data, go to Edit and select Select All or manually select the data lines you are interested in by
holding down the left click button while you move the cursor over the lines selected. Right click on the
highlighted data and select Copy.

Open an Excel spreadsheet and right click in the upper most left cell you want to work with, right click and
select Paste.

1l. For Computers with Adobe Acrobat:

A.
B.
C.

Go to File on Toolbar at top of page.

From drop down menu, select Export.

The Oracle Application page will open. On the bottom you will see a message “Do you want to open or save
XXXXX”. Select SAVE.

D. You will receive a message box that the download is complete. Select OPEN
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The View Downloads window will open, select the download you created and from the drop down menu
select OPEN WITH.

Select Microsoft Notepad.

A notepad will open with all the data you requested.

To date stamp the version of information you are using, go to Edit and select Time/Date

To export the data, go to Edit and select Select All or manually select the data lines you are interested in by
holding down the left click bottom while you move the cursor over the lines selected. Right click on the
highlighted data and select Copy.

Open an Excel spreadsheet and right click in the upper most left cell you want to work with, right click and
select Paste



